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Welcome to the Comprehensive Plant Design System for SolidWorks, -The world's most popular program used fo
the design of 3D Parts & Assemblies -. This systé#®aldPlant It is created to ful'll the needs of a Piping Designer who
wants to design a processing plant in a SolidWorks environment. Thus, SolidWorks users who need a Plant Design Syste
will get the most e"cient program through unique, smart and well-prepared tools. Moreover, SolidPlant is an add-in to
SolidWorks, which can work on the standard SolidWorks package. So this can help you save costs on the program.

SolidPlant truly understands SolidWorks users' need for a Plant Design System. SolidWorks alone cannot answ
this need, even though it already has a routing module. SolidPlant is providing various smart tools for working on the plant
design application starting fronPiping Specilcation Class preparation, Steel Structure Modeler creation, Equipment
Model creation, and Pipe Routing Model creation. From all this information, users can expdills Of Materials (BOM)
for using in material assessment and order, as well as automatic extractidPiphg Isometric Drawings for using in
Fabrication or Commissioning of Plant. Additionally, users can alsoGgzteral Arrangement Drawing (GA) in order to
be used in piping installation at the plant site.

Thus, SolidPlant is a highly interactive system with realistic Values & Fittings and can be called the best solutioi
for SolidWorks users who are seeking for a real Plant Design Software without the need to use additional software
SolidPlant has everything included. A full range of e"cient features and tools with precision for quality works.

In starting the actual working procedure to Design a Plant System, it is important to understand the basic design
concepts of piping design and the users must follow certain crucial steps. We will start from importing P&ID data from a !le
(i.e. Excel or xml) which is to be used in the system, then this information will be used in the creation of Equipment
Modeling, Steel Structure Modeling, as well as Piping Designing. Users can utilize all the smart and unique features of th
application which will be explained in this manual in later chapters.
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Chapter 1 SolidPlant User Interface

Chapter 1-1 SolidPlant User Interface
In this chapter, we will learn basic information regarding the SolidPlant User Interface.

First, we will learn how to start the SolidPlant program. Then we will learn about Tool Bars and Ribbon System ir
SolidPlant, which will be classi"ed according to application groups and types of works.

Next, we will learn about SolidPlant Project Manager, which is used for all project management tasks including
copy, backup, restore, as well as data control in the system.

Then, we will learn about Control View Model, which is all about how to use tools or features to look at various
views of our models, because there are usually many components in the plant we build, we need to learn the basics.

If we already have a plant model, we can walk-through our model by using the Walk-Through Model feature in
order to see how our Plant or models look like in a real environment. If you want to present the piping, equipment and
structural placement that you have designed to your superior and/or leading engineer, client or contractor, you can use the
walk-through feature and make a video recording for your presentation.

Chapter 1-2 How to start program

In this step, we will learn how to start the SolidPlant program. In this case we will use the shortcut icon on the
desktop after the software has already been installed, it is named 2SolidPlant® as shown in image below. We can also ope
the SolidPlant application from inside the SolidWorks environment.

Open SolidWorks 2014 > Tools > Add-ins >S olidPlant.
Next, if we want to us&pecCreator, which is used for creating standardized pipe class speci“cation, click on the

aSpecCreator® icon on desktop, the functionality of

SpecCreator will be explained in the next chapter.

olidPlant §—

Comprehensive Plant Design for SolidWorks.

SolidPlant

Sma{te;‘ T AN —

SolidPlant
P&ID 2015

solidplant3d.com

Shortcut to start SolidPlant and
Spec Creator on desktop

After you have started SolidPlant using the shortcut, you can see that you have opened SolidWorks together with
SolidPlant. You can see SolidPlant Project Manager ‘
on the right panel as highlighted below.

2,
DS SOLIDWORKS

2015

SolidPlant Project Manager Tab just by clicking on the
below shown icon or tab.

SP
Fé pS SOLIDWORKS

2015

SolidPlant Project Manager
Click to display this task pane tab.




mm SolidrPlant

Then if you want to see the projects that you have already created or opened, click on Active Project, drop down

will show you the list of Projects you have created.

Select project.

Active Project

I

SolidPlant_Sample
test
sample

Solidplant demo

sp demo

TANK FARM PROJECT

SolidPlant Project
i-i Pipe Routing

As an alternative way, you can also open a project by using the Open Project toolbar. When you click on the oper
project icon, a dialog box will appear which gives an access to browse to your speci“c folder location. Then you can make

your desired selection of project in the folder and click to open it. See below for pictorial representation.

0.3.6-5-9-5 8 SE-

Now your desired project model has been opened in the window. You can notice on the left side panel that there
are separate folders for equipment, piping, and structure. These are folders where all your project assembly disciplines witt

respect to structure, equipment and Piping will be saved respectively.

Chapter 1-3 Toolbars in SolidPlant

Next, observe above, and you will see SolidWorks Toolbar that we regularly work on. But here you can obserw

that SolidPlant Toolbar is added along with SolidWorks toolbar, which @odidPlant, Structure, Equipment, Routing,
Component, and Drawing. Later chapters will explain you in detail about each Toolbar respectively.
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Chapter 1-4 SolidPlant Toolbar ‘

O

Let's learn about the "rst Toolbar, which is namé&alidPlant. Basically, SolidPlant toolbar can also be called as
Standard toolbar where all the basic functions liRéew Project, Open Project, Save Projectand Restore Projectare
listed. It also includes tool calleSpec Creatorfor opening the saved Pipe Class speci“cations to modify or to create new
Spec.

Additionally, we haveTAG ManagerTool for importingP&ID data, TAG Finderfor searching the 3D models from
the tag data we already have. And we also hansert Layout tool, which will be helpful in importing 2D layout or Plot Plan
drawing of your plant as 2D reference for allocating equipment or Structural Models.

SolidPlant also has tools for creating reports of the Project nameBragect Report, and showing property of
the project inProject Property Tool.

Additionally, we have functions or features related to handling or moving equipment which &reve and
Rotate Component. If you want to look at the properties of any component, you can make use of the features called
Component Property.

Finally on the SolidPlant Tool bar we have di#erent viewpoint features to look at the overall Plant in di#erent
views agrront, Right, Back, Top, Leftand Bottom. And Isometric views aSW, SE, NVEind NEwhich will be very handy
when working on di#erent areas of the Project. Next, there are tools for viewingh Table view to rotate models and
Rotate view for rotation of the overall plant model.

¥ About SolidPlant Icon shows the version of SolidPlant you are using.

Chapter 1-5 Structure Toolbar ‘

O

SolidPlant provides you with veryynique and Smart Featuresto create your Plant or Project. For Designing or
creating a ProjectStructure plays an important role in any development be it at Construction of a Building or Commission-
ing of the Power Plant.

So, let's discuss about tf&tructure toolbar in SolidPlant. It comprises of the most unique and important features
starting from creating Grid known aStructure 3D Grid which acts as reference for locating columns and beams. Addition-
ally, beams that you use will conform to the various standards that SolidWorks users can choose from.

Moreover, SolidPlant has many Smart features which will make your design process an easy task. The Mo:
frequently used structures in plant works can be modeled with just a few clicks, saving most of the time and e#ort of the
designer, such astair, Spiral Stair, Ladder, Handrail, Platform, Walkway, Floor Plate, Bracing, Truss, Footingand
many more¥a., this helps in reusability of the models as well as an easy way to change and set to the desired values.

In addition to this SolidPlant has features liketo Trim, Insert Connection, Steel Codeand Structure Building
and also we can make a report usidgsign Member TAGfeature in order to generate Materials Cut list of structure.
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Chapter 1-6 Equipment Toolbar ‘

O

Designing or Modeling of Equipment plays a vital role in Plant Design. Generally most of the Equipment models
are not available in many 3D applications and sometimes we need to import the Pressure Vessels, Heat Exchangers ar
customized pumps which are designed in other applications by using universal standards, but we're unable to do so.

SolidPlant provides the solution for such problems. Let's see how?

A solution for such kind of problem is in SolidPlanEgjuipment Toolbar. Equipment toolbar comprises
important features which includeCreate Equipment for creating equipment from the standard library of SolidPlant,
Convert Equipment which converts the di#erent formats of equipment to SolidPlant's formats in order to use or import in
to your projects.

Additionally, SolidPlant has a feature known &Jjuipment Nozzle for determining nozzle position on
equipment to make a starting point for piping work. It is very common to have multiple equipment in any kind of plant
whether it is small or big, to facilitate this kind of requirement SolidPlant has features known as Linear Equipment and
Circular Equipment which copies the equipment and places it in either linear pattern or in circular pattern.

In some cases, if placement of equipment is de"ned wrongly then you can make use of the featuréddike
Equipment and Rotate Equipment for movement and rotation of any equipment in your project.

You can make use of thequipment Property feature to know the properties of any equipment in your project
or plant.

Chapter 1-7 Routing Toolbar ‘

O

Piping Design is a very important task in Plant Design. Routing a pipe from start to end point requires a wise
decision to minimize the material, e#ective use of Fittings and shorter distance. In order to accommodate these require-
ments SolidPlant has come up with a smarter Idea of routing knowA%®mart Route®

Piping Design or Routing in SolidPlant is categorized into 3 types:

t .BOVBM 3PVUF
t "VUP 3PVUF
t 4ANBSU 3PVUF

Let's learn brie$y about these 3 routing modules. Before that let's have a look aRthaing Toolbar. The

Routing toolbar comprises of all the features that are very useful when you design a route.

Manual Route :This is the point-to-point routing, where user has to specify the routing direction manually.

Auto Route : This feature is very handy for a Piping designer. Whereby the user has to just specify the start and
end point of the route, in most cases it will be nozzles of the equipment.

Smart Route :A very Unique and Smart Feature which will be very much handy for any user of SolidPlant. As it
ful'lls the motto of SolidPlan®Route it your Way®. Smart Route is a feature that fetches the information of a line list from
the data you have imported earlier using Tag manager, then generates a pipe route intelligently and also prompts for the
"ttings like valves, control valves and strainer etc.

SolidPlant Routing toolbar has additional features which helps in rebuilding the single component and regenera-
tion of whole pipe line usingRebuild Component and Regen Routefeatures and if you desire to modify the pipe route,
the smart features which come in handy that includ@elete Component, Delete Route, Assign Length of pipes and
Change Size.




- SOIidPIant www.solidplant3d.com

SolidPlant also has additional features or Advanced Features for piping work, which incdie Pipe and
Elevation Move Pipe. In the case of making an expansion loop the advance feature which is caigdRoute will help you
create it better and faster. Moreover you can rotate any piping component after placement in route line making use of
Rotate Component feature and get the component property by using the Component Property feature. The more
advanced tool in Routing toolbar iRipe Support using this feature you can place di#erent types of pipe support at any
desired location on your route line.

Chapter 1-8 Component Toolbar ‘

O

Let's have a look at th€omponent Toolbar in SolidPlant. SolidPlant provides you with the desired components
or "ttings which are generally used in piping design. You can observe that there are various components including many
types of pipe "ttings, and $anges for valves. The user can utilize these additional components. But, "rst you must originally
have data created in pipe spec so you can retrieve data for using with the appropriate models in each component type.

Chapter 1-9 Drawing Toolbar ‘

The last Toolbar in SolidPlant is calledawing Toolbar. This toolbar includes features for the user to
utilize after the model has already been created. The "rdben PCFby which you can generate PCF "le in order to create
Piping Isometric Drawing. And you can create drawing wittew Drawing feature and take dimension on drawing in GA
or General Arrangement Drawing for installation at plant site.

Additional features on this toolbar aBOM with this you can generate Bill of Materials, and annotation features
like TAG, TOP, CO&nd BOPthat you want to show on the drawing. You can instantly get this information by making use
of above features. Detailed information regarding all the features will be explained in future chapters.

Chapter 1-10 SolidPlant Project Manager

Till now you have understood about SolidPlant Toolbars, let's have a look at the task panel at the right side that is
called SolidPlant Project Manager. This task panel is the main panel for working on your SolidPlant project. You will see
the basic information of the project that you are working on. Here you will notice the project name and the units used in
the project.

SP

e
SRR

SolidPlant Project Manager is comprised of all the basic operation of a standard toolbar to facilitate the availabili-
ty of the features in multiple places such as creation of new projects \W#w Project feature.

And to open the project, you can instantly browse in the folder wiflpen Project feature. Moreover, you can
also copy the complete data or information of the older SolidPlant project to use in the new project @ihy Project
feature.
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To take the backup of the work done by user for each working day, you lgaekup Project feature for this
purpose as well. SolidPlant hd&estore Project function to retrieve the saved project for future use. In addition, we also
haveAdd to Group function which will help you in Network environment an@lose Projectfunction to close the project,
and Project Property function to show status of settings in the project. Below picture shows you the detailed pictorial
representation of all the functions on SolidPlant Project Manager.

Next, let's discuss about the Document List as you can see in the adjacent picture.
In the Document List, you will see all the nodes of di#erent items indicating various data.

For examplePipe Routing, you can expand the node to see its data, all the line
numbers that you have created and imported from the P&ID list will be shown here, in
this you can observe that line numbers are shown in di#erent color codes, these colors
indicate data status.

For example, the coldBlack tells you that the model and database have already
been placed in the project.

The coloRed tells you that there is only data of the tag which you imported from
the P&ID list, but model is not created in the project.

And the colorBlue (which we do not have now), if the color Blue is shown, this
means that we have both data and model but we have not brought that model into the
Main Assembly of the project.

Please notice that data of each item will be separately grouped. For example, Equipment, all the equipment
related data will be shown in equipment group. If you want to know the location of any equipment you can just
double-click on the tag name, the application will zoom-in to the equipment location in your project.
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Next, in the below picture you can observe the nodes GA Drawing, Isometric Drawing, and Document. These are
all nodes that show status. And when you use attach or import the data documents, they will be listed under these nodes
respectively.

Let's move on to the next task pane, the important feature under SolidPlant Project Manager, which is called
asolidPlant Pipe Routing®

= O

SolidPlant Pipe Routing is the smarter way to route your piping in today's world of smart technology. This pane is
important for de"ning Line Name or Line Number which will be used for pipe routing in the project. Active route "eld
shows you the active route or line on which you are working on.

Apart from import P&ID you can also create the new line number usingNesv button just below the active
route. If you wish to delete any route you can make uséefete button to delete it from your model.

At this point, please notice that we are selecting Line 001. You can select the desired Pipe Spec that will be use
to design this line. You can also set the pipe size as desired. In the same way, we can set Insulation to desired thickness
required. In some cases you want to modify your routing direction after drawing the start to end point, in this case you can
make use of the optiorDisable Routing Mode to avoid generation of pipe automatically as you exit sketch and can check
the box later after you complete your editing.

Apart from the above mentioned features Pipe Routing tab also comprises of di#erent important Piping sketch
Tools. As shown in the adjacent image, we have many types of Snaps for pipe routing to select from. Additionally, we als«
have options of Slope feature. This is important for pipe routing
in slope. You can set it as proportion, for example, 1:100 or 1:50.
When you want to use it, just clicklope button. It will then route
the pipe in slope for you without the need of calculating the
length or degree before.




mm SolidPlant

Chapter 1-11 Control View Model
Next topic is Control View Model, which is about looking at models in various viewpoints. First you have to know

the basics. Please notice the lower left corner. You will see the axis that is called Triad, and notice that its Z-axis is in vertic
direction. This is common in plant design systems. However, this is di#erent from the part design in SolidWorks, in whict
Y-axis is commonly in vertical direction.

<=

Let's move on to the model viewing options in SolidPlant. You can make use of SolidWorks feature called Orienta:
tion to create views from di#erent viewpoints, which you have previously used for your convenience. For example, if you
want to see the plant layout in Top, Front or Right direction, you can instantly do it or can use model viewing tools in
SolidPlant Toolbar. And also can make use of the di#erent Isometric views which are available in the SolidPlant toolbar t
view the whole plant in di#erent isometric angles.

<=

Chapter 1-12 Walk Through Model
Next you will learn about the feature for Walk Through Model. After you have "nished creating your model, you
can walk through the plant to check or review your complete plant model as well as to record it as a video.

Now you will learn what we need to set when preparing for Walk Through.
Tools >Large Assembly Mode.




mm SolidPlant

And then go to
View > Lights and Cameras > Add Walk-through.

After that, click on Viewport Settings, then choose at the vertical structural axis if the arrow is showing in down
direction use $ip to show up. And now click Start Walk-Through as shown below

There will be a dialog box showing Introduction and guideline for using keyboards and mouse in the
Walk-Through, then click OK.

<=

After that you will see that there is a Box Panel appearing at the bottom. This is the tool to handle or walk-through
into the plant. Basically you can set, increase, or decrease speed. Then you can click button to walk-through. Additionally
you can also record and save it as a video by clicking Record button, then walk-through as usual. When "nished, if you wan
to playback the video, you can click Play right here.
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And when you are ready to generate a video "le, you can click at the Generate Video button. You can also save ¢
compress the "le as required.

Chapter 2 How to create Project data with SolidPlant3D Project Manager

Chapter 2-1 Manage a Project System and Model Layout Setup

In this chapter, you will learn about SolidPlant3D project management. This includes how to create a project, and
how to insert model layout into the project. First we will learn about how to create a project using a tool called SolidPlant3D
Project Manager.

Next we will learn about the system settings and conditions related to settings before we start working on the
model or project. Then we will insert 2D Plot Plan or Plan Layout to be a reference for our model, including Equipment
Model and Structure Model in our Plant Layout.

Chapter 2-2 How to create project data with SolidPlant3D Project Manager
Now we will look at the "rst topic, which is about how to create a project in SolidPlant3D. First, go to the
SolidPlant3D Project Manager Task panel, and click here.

SP

A4 -
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Then observe the Toolbar of SolidPlant Project Manager as shown in the image below. Click on the button which
is called New Project.
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Let's have a look at how to input data, Project Name, in which you will input the name of the project. Next is
Project Description, in which you can enter the brief information of the project.

i
S

As you can observe the third !eld in the Create New Project windoWiigctory. This shows you the location of
the project database. The default folder location is in drive C, which is c:\SolidPlant Projects\ that we will now use for illustra
tion. You can change the folder location to your desired drive on your machine or on server where you desire to locate your
project database with the small browse button at right end of the directory !eld. When you click on the browse button the
browse for folder window will pop up as shown in the below picture.

Next, just below the directory !eld i®roject Unit. Please notice that SolidPlant is having 3 modes to select from,
which arelmperial, Metric, and Mix-Metric.

Imperial units mean the Outside Diameter of
pipes that you are about to use will be in inches, and
the pipe-length summation will be in feet and inches.
On the other hand, if you use Metric, OD of pipes will be
in millimeters, and the pipe-length summation is in
millimeters and meters. As for the third type: Mix-Metric,
OD of pipes will be in inches, and the pipe-length
summation is in millimeters.

Here we will choose Mix-Metric, then click
Create button below.
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When the project is successfully created you will notice that there will be the project name displayed in the active
project "eld, in this case it is named as SolidPlant Project.

Now SolidPlant Project Manager is all set to start your design of a new Plant. Please notice on the left side tas
pane that there are 3 default folders, which are Equipment, Piping, and Structure.

Chapter 2-3 How to change settings in project properties
Let's learn how to modify the settings of the project we are working on. First, click orSthlelPlant Project
Manager to activate the task panel. Then click on the tool calject Property as shown below.

After you click it, the Project Property dialog will appear, and there are tabs for various property settings. The "rst
one isGeneral tab, in which we can see the project name and the path folder in which the project directory or database is
stored. Here please notice that when you click on the path, it will open the folder where our project is located without the
need to open from outside of the application. Now please close this.

Next important thing is theProject Unit, which we have selected from the last chapter. And belowPi®ject
Properties, which you can directly input the details into it. For example, we can instantly input the project description and
lots more here.
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Next, let's look at the second tab, whichR&ing Speci'cation. Please notice that when you click on it, the path
linked to the pipe spec used in the project will be listed belowspeci'cation list. You will see a default speci“cation
named asDefault andDemo in the list. As you can observe from the below picture we have two buttons at right bottom
corner of the project property dialogue box, this will be helpful in adding or deleting a spec, which you want to link in the
project.

If you want to add spec, click d#° button and select the spec you want to use in the project. Please note the
extension of the speci“cation "le i§mdb°

To remove any unwanted spec from the project simply select the desired spec linRXfSkeutton to remove the
spec from your project.

Next, please look at the third tab, whichNodel Setup. This tab is for Snap settings, which are frequently used
in the project for model creation. These Snaps are in fact the Snaps that we have already in SolidWorks, but we brougt
them into SolidPlant so that the user is able to manage them easily.

Next, below is Shaded Quality, which we can set shade
and wireframe for display quality. However, this depends on the
hardware performance of each computer. If we set for high quality,
it will utilize the computer performance.

Have a look at the next taline Number Format. This tab shows the information regarding the line number
format, user can arrange the desired information to show up in line number. DefadM&in size-spec-service-pipe tag
or number-insulation®

<=
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Next, let's look at the last tab, which@mponent Color. Component Color sets the colors of major components
like Equipment's, Pipe Route, Pipe Components or Fittings. If you look at the Component drop down list, you will see thai
they are separately grouped as Equipment, Pipe Routing and more¥a. In this tab we can assign di#erent colors for each o
them.

For example, if you are now active at Pipe Routing, you can observe in the adjacent ihagign color by% By

default it is set taService. That means SolidPlant will show the di#erent color for pipe with di#erent services, you will see
each service name and its color.

<=

Assigning color to the component are of di#erent types the default isBarvice as explained earlier and next
one is By Nominal Diameter, if you choose the optioriNaiminal Diameter, this means the pipe color will change in accord-
ance with its size.

=

However, our default is set to be by Service. For instance, Steam line color can be set as required, such as red
blue. Color setting can be easily done by just choosing the name or service of the pipe line and then double-click in the
color "eld, and now you can select the desired color here, pictorial representation is shown below.

Well, all we have learned in this part are the details of how to change default system settings of the project used
in our project or model.
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Chapter 2-4 Insert plant layout as reference to 3D models

Designing of the Plant will start with creation or Preparation of the Plot Plan or Plant Layout. Generally most of the
industries worldwide start there plant layout in 2D platforms as their regular practice. Keeping that in mind, SolidPlant has
come up with an Interesting feature callebhsert Layout. To import the plot plan which you have already created as 2D
detailed drawing which explains the locations of equipment and steel structure. SolidPlant will import this 2D drawing as
reference to your plant. So, the user can design the plant more accurately, faster and more $exible in comparison to the
other platforms.

Now we are ready to try the Insert Layout feature. First, activate the SolidPlant toolbar, then clickerhLayout
command.

After you click the Insert Layout command, the dialog box of Insert 2D Layout will appear. Then you can input the
name for your layout, which will be shown in Feature Manager on the left hand side. For Example we will use the name
asolidPlant layout®in this session.

Next, the second box is for Elevation, and its default is assigned to zero.
However, we can set its value as required. If in a case that your plant is at a higher
level, you can set its elevation at this point. Here we will set it to be zero, and then

click OK.

Next open the dialog box to browse or to locate for 2D CAD "les. At this point, please notice the format of "le
types. Let's change from Dxf to Dwg. Then we browse to the folder where your 2D layout drawing is located (for instance
let's say Dataset folder located on desktop where our 2D layout "le named SP plan-layout is placed). So, browse to tht
Dataset Training folder on desktop, select the "le SP Plan-Layout which will be imported to use as reference Plant layout it
the SolidPlant, and then click Open button.
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Then the process of importing "le dialog box will appear (which can be .dxf or .dwg import). And certainly in this
case, we will use 2D Sketch. Then click next.

<=

s  IEEEETE |

And the preview of our Plot Plan drawing will appear. At this point, change the unit from inches to millimeters,
then click next once more.

And click "nish button. There will be a dialog for enabling Explode Blocks option

Then click Yes. The process of import Plot Plan is successfully "nished.
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You can zoom to check equipment positions including positions of vessels, pumps, steel structures, and tanks.

Chapter 2-5 Backup & restore project system

Backup of the project is mandatory in today's world. None of us know what will happen next minute or
sometimes the new modi“cation which the user worked on may not be implemented in the current stage of the project.
So, making backups of the project from time to time saves lots of time and e#ort of the Piping designer and also saves
money. Backup is useful because we can save the latest working status from time to time. If you require the information
from the past time period or past days, we can retrieve the data and make use of it at any time.

Well, now we will learn how to creat®ackup of our working project. First, we will go to the SolidPlant Toolbar
and click to activate it. Then go to th®ave Projectcommand and click it.

The Backup Project dialog box will now pop up, and we can input a name for the project that we want to back up.
We will use the name 1-First Project Backup. When "nished, click Create button.

The dialog box saying 2Backup done® will appear, then we click OK.
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If you want to restore or retrieve the backup project from the older time, you can do it by going to SolidPlant
toolbar and click theRestore Project feature.

As from the Restore Project dialog box shown below, we can see the project which we have taken backup earliel
is listed and we can use the mouse to select it. Or if we do not want it anymore, we can delete it as well by usiKg tie
left bottom corner of the box.

Now supposing that we want to restore this project back, we can select the project and click Restore.

And then Yes to con"rm. After that the current opened project will be closed and the backup project will be
restored automatically into your working screen.

Thus, we can make use of the restore feature to check the status of the work done by the user day by day.
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Chapter 3 Create Pipe Class Speciescation using SpecCreator

Chapter 3-1 Pipe Class Speciscation

A complete Plant design is a combination of multiple processes. Each process has its own temperature and
pressure ratings, to withstand these processes we use dilerent types of materials. For instance a plant may have a higt
saturated steam line, high-pressure line, low-pressure line, chemical line, water line, instrument-air line and other services
Each service or line is dilerent in operating conditions like design temperature, design Pressure, Operating Temperature,
Operating Pressure and Material grades.

The most important element of a plant design system is how the graphics work with the database. We
understand that the piping engineer does not want to spend a lot of time on creating and managing the database. Prepar-
ing a database with an enormous amount of data will traditionally take a lot of elort and discipline in order to make sure
it is done right from the start with the highest level of accuracy.

Chapter 3-2 SolidPlant SpecCreator
SolidPlant's SpecCreator provides a great tool for the engineer to prepare piping data as easy as possible withou
having to compromise on accuracy. SolidPlant is a strong advocate of the corff2pit Right the First Time!°

SpecCreator is SolidPlant's in-built application which installs automatically when you install SolidPlant3D that
can create/edit spec data, Import/export catalogs, and create/edit specs for SolidPlant3D. SolidPlant uses Specs an
Catalogs to create a set of data specic to a project. Without the creation of a spec or specs with correct data the compo
nents placed in SolidPlant may re#ect the required data for the project. And by not limiting a spec by removing unneces-
sary components errors may be incurred by the placement of the wrong pipe, valve, elbow etc...

Catalogs

A catalog is the repository for all component data regardless of any speci'c project needs. The standard installed
catalogs are there to be a general library for all component data and any "ltering for a project should be done though the
spec. The standard installed catalogs have most of the components required by all SolidPlant users.
Specs

A Spec is a "ltered list of component data from selected catalogs. For example the base spec CS150 only ha
components with a pressure ratings of 150lb and 300lb. creating comprehensive specs prior to starting a project errors by
reducing the available components for placement. All "ltering of components should be done though the spec.

Chapter 3-3 Standards and Catalogs available in Library

SolidPlant SpecCreator is installed with the standard catalogs. For example, ANSI/ASME standard which is we
known by all the piping designers worldwide. The SolidPlant Library also includes standards like JIS, DIN and many mort
The famous brands from various manufacturers such as Crane, Ladish and Fisher are also included in the library, so the u:
does not need to worry about the standard catalogs everything is readily available in SolidPlant library.
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Chapter 3-4 New Spec Wizard
This chapter will teach you how to create New Spec using 2New Spec Wizard® feature. In order to create a ney
spec you need to open the spec creator "rst. Access 2SpecCreator® from the desktop icon.

SpecCreator splash will appear and SolidPlant Pipe Speci“cation Creator will open. You can also access th
SpecCreator from the SolidPlant3D tool palette.

Now have a look at the tool palette SpecCreator.

You can Create New or Open the existing spec, New Spec Wizard tool, add new table, delete table and many more...
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We will learn about New Spec Wizard. The word Wizard itself explains that this feature will help in automate
complex tasks by asking the user a series of easy-to-answer questions.

Click on the @2New Spec Wizard® feature New spec wizard dialogue box will pop-up.

You have to select the project name in which you want to create new spec, specify a name and select the Speci'ca
tion module from the drop down.

Next screen is the catalog selection, select the catalog you require and click on move button. You can click on
aSelect All°if you require all catalogs.

Next screen is to select the component table you require, you can select all or only few components as per project
requirement.




mm SolidPlant

Next screen is to select the min and max size, schedule, rating, end condition, facing, class name and material.

J[F >
>
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Next screen is the summary screen where you can see all the selections you have made, if you want to chang
anything click on #Back® button to go to pervious pages. Once "nished with your selection click on 2Finish®

All the components you have selected will be generated with the min and max main size.

e

Chapter 3-5 Edit the Spec in SpecCreator
As you saw creating a spec in SpecCreator is simple and easy. Let's see how to edit and detail setup for pipe ar
"tting.




mm SolidPlant

You can update the material grade for the all the pipe sizes just by adding in above @Mat Grade®

Select the material from the drop down. Material grade will be updated for all pipe sizes, you can observe the preview.

Now, we can customize the Description of the pipe just by edit or adding whatever we need to display, "rst we
write @8PIPE SCH (right click to select the schedule, so schedule will be updated accordingly)

/IPX BEE JO UIF TBNF 6FME i1& 4.-4 " (3 #w UIFO EFTDSJQUJPO XJMM CF
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Let's add second row for the pipe size 2 to 10 inch. Click on the 2+° button in the row control menu then a new
empty row will be added. Update all the information, copy the description and paste edit if needed.

XO NJO TIJ[F
NF 1*1&
EF " #

o

In the same way we can add Fitting, Flanges, Valves and all type of components.

-FU T TFF IPX UP BEE '"JUUJOHT $MJDL PO UIF 6UUJOHT UBC TFMFD
cond 8SWF°

Now add a second row, change the min size as @2° max sizes as #10° and end condition to BW
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/PX DMJDL PO UIF i%VQMJDBUF 3PXw CVUUPO UP EVQMJDBUF UIF SP
can now see the preview of the Tee component in preview.

After you have prepared your desired spec for all the components you require, click orfGlem Spec®to
generate only one spec which you selected or clicka@¥en Spec All°to generate all the component specs.

Process bar will be shown at the time of Spec Gen

And after generating the spec for all the components, SpecCreator will pop

Chapter 3-6 Print Preview of the Spec in SpecCreator
After we generate the Spec, if we want to verify some of the components we can print the spec using Print
Preview Feature. Click on tH@rint Preview® button.
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8IFO zPV DMJDL PO UIF QSJOU QSFWJFX CVUUPO TFMFDU QSFWJFX
you required to show in the print preview (just double click on the name it will be added). After you added your desired
columns click 20K®

You can see the preview of the components

To adjust the rows click on @Auto Fit® check box. You can also sort by @Component type® and click on the 2Print
Preview® button.

You can now see the print preview in the page format click 2Print° to print the spec.
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Chapter 3-7 Search Component using Catalog.
Sometimes we want to add a speci"c component but we're not sure which catalog it is, so we search in the
catalog. Click on the 2Add Catalog® button.

Catalog dialogue box will pop up, the list of catalogs we're using to generate the current spec will appear. Now
click on the @search® button

Search catalog dialogue box will pop up, we use few constraints to search the component, for example we want
UP TFBSDI GPS B SFUVSO UIFO TFMFDU i$SMBTT /IBNFw GSPN UIF ESPQ E
and hit2Search® button.

The component's catalog will appear in the search "eld, select and click on 2Add Selected® button.




mm SolidPlant

Chapter 3-8 Branch Editor in SpecCreator.
This chapter will teach you how to use the branch editor in SolidPlant SpecCreator. Click on the Branch editor tak
in the SpecCreator.

You can observe the branch table where main size on the x-axis and branch size on the y-axis. Legend is given i
the top right corner. As you can observe from the above picture there is no reducing tee in the table. Go back to the spec
FEJUPS 6UUJOHT UBC EVQMJDBUF UIF SE SPX BOE DIBOHF UIF DMBTT OF

/IPX HP CBDL UP UIF CSBODI FEJUPS :PV DBO OPX PCTFSWF UIF i53w XIJLC

You can set the stub-in connection for some sizes manually. Select the column which you want to set the compo-
nent just by selecting and dragging.
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From the branch "tting drop down select2S° and click on 2Apply to table®

This is how we can use the branch editor to show the various types of "ttings used in branches for di#erent sizes.

Chapter 4 Project Initial Data Setup

Chapter 4-1 Project Initial Data Setup

A vast amount of Drawings and Documentation is required for the Design and Construction of Power, Process or
Plant facilities which are frontend and detailed engineering drawings. The main engineering documents used on a regular
basis by the engineering sta# for smooth and e$cient running, maintenance and upgrading of facilities are Piping and
Instrumentation Diagrams also called as P&ID. In fact, we will start from the concept of frontend. This begins from design
ing in the system and process of plant to see what are the necessary items or things to be used in the design of the plan

Generally, Plant design will begin with Drawings and Documentations. This may start from the Equipment layout
Diagram or Equipment General Arrangement Drawings. After equipment layout is done, the process %ow will be roughly
determined. The frontend design, which does not have much detail, may be called PFD, or Process Flow Diagram. Howeve
the next design level, there may be more details. For instance, in our process line, we might include valves, control valve:
and instruments, which is known as P&ID.

P&ID is the complete process %ow and detail information regarding pressure, temperature, values and
Instruments. Designing of P&ID will be done using the SolidPlant P&ID application. After you design P&ID's in SolidPlar
P&ID, the P&ID application is having an excellent feature called Sync to SolidPlant3D to synchronize all the data lik
Equipment list, Line list, Nozzle data, valve list and Instrument list directly to the SolidPlant3D application with automatic
creation of the Project. If you want, you can also export the P&ID list in to a single excel "le. Which will be useful for veri'ca
tion of equipment and Line list and also comes into handy when you start designing your project in SolidPlant. Next, we
will learn in detail how to import P&ID data into the system, which is not designed in SolidPlant P&ID.
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Chapter 4-2 Introduction to concept of P&ID data
We will look at an example of a P&ID Drawing to see how it looks in the form of Process & instrument Diagram, a
well as the related data import. The picture you have seen above is called P&ID Drawing, which shows all process details.

In the above drawing we can see a Tank, two Pumps, two Heat Exchangers and one Tower these are the (piect
of) equipment we are going to use in this training session.

After we have designed/created the P&ID Drawing using any other P&ID application all the data should be export-
ed from it. Please notice that they are exported in the form of an Excel !le. Look at the data we need to use in the
worksheets. The !rst one is Line List. Look at the !rst column, which is@Tag® In the tag, there will be all the details including

size, spec, service, and tag number. We can also see the connectivity details like from where and which equipment this lin
starts and ends. We can also have the individual information of the line like Spec, Size and service.

Next, the second worksheet is called Equipment List. This will show you the detail information about Tags of
equipment. The details include complete description of equipment and tags.

Next is Valve list. This will show you the detailed information about the valves which are used in this P&ID. As fron
the details, it shows type and size of valve, as well as on which line number the valve is located.
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Next, have a look at Instrument list. These are tags of instruments used in the drawing.

Next, is Nozzle List. There will be Tags for each and individual nozzles of the equipment.

And the last one is Control Valve List.

Import of P&ID data into SolidPlant3D will be discussed in further chapters.

Chapter 4-3 How to import P&ID data into SolidPlant3D project system by using TAG Manager

In this chapter we will learn about how to import P&ID data into SolidPlant project by using the tool called Tag
Manager. SolidPlant3D provides the users multiple ways to access the toolbars, First way is to access from the SolidPla
tool palette. Click on SolidPlant -> Tag Manager.
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Or by the other way, we can access the Tag manager at SolidPlant Project Manager, under the Document Lis
section, as shown below.

When you click on the Tag Manager Button a dialogue box will popup which is Tag Manager Dialogue.

Chapter 4-4 Import Process Line List

In order to import the Tag list, "rst we have to map the P&ID data sheet with our Tag manager. Let me explain how
we can map the data sheet. In the below picture you can see the component type, component type means selection of
data which we use to import; in this case we are importing all the data like Equipment list, line list, valve list and nozzle lis
etc.. Line list is also known as Pipe routing. So, make sure when you import the data, pipe routing is selected in the compc
nent list then hit 2import tag® button.

When you click on the import tag button, a dialog box will appear which is, "le selection window. Please browse
to the desired location where you saved your P&ID data sheet which is in excel format(.xIs)
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For illustration we are using Dataset Training folder.

When you select you're desired folder, select the excel "le which is the P&ID list. We can see the preview of this "le
In this "le we will be having the detailed information of all the P&ID data such as Valve List, Nozzle List, Line List, Instrumer
List, Control Valve List, and Equipment List. Select the "le-> click open

When you click Open button a dialog will pop up to con"rm our tag import from Excel. And certainly, we will
choose Pipe Routing as Component Type, and choose Line List from Excel Worksheet. Click OK.

Then a dialog will pop up with empty "elds, we have to map the data for each "eld in the project. The "elds in the
dialog box are Tag, Description, Service, Spec, Main Size, Insulation Thickness, From Equipment, To Equipment, Mater
Schedule, and Rating.

We should map the respective data with our P&ID data sheet. We will try to do this. Here | choose Line Number fo
Tag, Tag for Description, Service, Spec, Size, Insulation Thickness, From, To, Material, and Schedule.
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These are the items we can select and set. Here we can add more "elds by clicking at Edit Column on the lower right.

The dialog box of Column Editor will appear, and we can input the data that we want to add. For example, if we
want drawing humber to be appearing in the Tag Manager, we can type @DWG_Name® here. As column names shouldn"
have space in between, so we will use underscore when space is needed. When "nished, click OK.

Now we have just created a new column, then we can map data. Choose the drawing number from the P&ID data
sheet and click OK
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After we click OK, it will return to the dialog of Tag Manager. We can see all the information such as line numbers
and other data which we have imported are placed in the respective columns. When done, click Close button.

When you close the Tag manager dialogue box, you can see now we have tags of line numbers and other data ir
the document list. If these data are not updated, you can use Refresh Tag button to update them.

Chapter 4-5 Import Equipment List

This chapter explains you about the import of Equipment List. If you observe the group item dequipment® there
will be no data of equipment tag, let's import the Equipment list from the P&ID data sheet in to the project document list.
The procedure will be same as Line list but, we use only Tag and description in equipment. Open Tag Manager.

Select 2Equipment® in the Component Type. Click Import 2Tag®
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Browse to the folder location where we kept our P&ID data sheet. Select-> Open

Select Equipment in the dropdown of Component Type, and change Excel Worksheet to be Equipment List. Then
click OK.

Now we will map system "elds and worksheet "elds. Here we choose Tag for Tag "eld, Description for Description
"eld, and Type, Insulation, and Location to be speci"ed if any. Then click OK.

After you click OK, you can observe our tags are imported to the Tag manager. Click close.
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Have a look at the group item of Equipment in Project Manager Document list, we can see that tags are imported
to our project. If tags are not updated, click Refresh Tag button to update them.

Valve list, Instrument list and Nozzle list are imported same as Equipment import as explained in the previous
chapters. After you import all the data, we will learn about how to import or create the Tag which are not in the P&ID data
sheet, in the following chapter.

Note: Please select the respective type in the component type.

Chapter 4-6 Create a new Tag which are not in P&ID data sheet.
New Tag can be created in two ways. This method explains you how to create a tag using Tag Manager. Let's se
how to do it. First, we will create a new process line which is not in our P&ID data sheet. Please click Tag Manager.

When Tag Manager is opened select Pipe Routing in component type. Now, we have a toolbar called Create Ta
just beside the component type. By using this function we can add more tags for every Component Type. Click Create Tac
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After you click on the create Tag in Tag Manager a new dialogue box will appear #@sdate Tag®dialogue. In
this, we can input new data such as L1001 for Tag, Description Process water, Service we can select from the list or we ¢
input new service that we want. Spec, we can choose from the pick list. Choose the size we want, such as 6 inches.

Color by : we can set color according to the criteria we want.

For example, if we want to set color according to service, select Service and the color will change according to
service type. If we set color according to Nominal Diameter, each size will have its own color. If Custom is selected, then us
should select their desired color.

When users design 3D pipe routing, the color blue will be used for all water systems, and the color red will be usec
for high-pressure systems, color can be changed just by clicking at Color Preview. For instance, to change the color yellov
click on the color then a color palette will appear select your desired color click OK. The color will change accordingly. Whel
done, click Create button, and click Close on this dialog.

After you close the Create Tag dialogue we can observe our new tag is added in the pipe routing line list in Tag
Manager

In the same manner we can create new tags for all the types. Second method of creating new tag will be
explained in further chapters.




mm SolidPlant

Chapter 5 Create Steel Structures

Chapter 5-1 Steel Structures

This topic will teach you how to create Steel Structures in SolidPlant 3D. Structures are the main foundation of
any construction. To design a detailed structure in projects it takes too many man hours. To reduce the elort of the design-
ers, SolidPlant 3D has developed smart functionalities in steel structures. That means with very minimal sketches SolidPlar
3D will generate most complicated structures within a very short time. Let's see in detail what SolidPlant can provide you.

SolidPlant3D has a Structure Tab as explained in Chapter 1. All the features which are useful for creating stet
structures are categorized under this tab. The frequently used structures are listed below: 3D Grid, Structural members
Stairs, Ladders, Platforms, Hand rails, Walk way, Pipe Bridge etc... And many more.

Chapter 5-2 How to use Structure 3D Grid

In order to insert a 3D Grid we require a reference point to snap and design the structural features exactly at your
desired locations. For doing this we import a 2D plot plan which is already drafted in 2D application with exact locations of
grid and equipment. We can change the view for our convenience, for example we want to see this area in isometric view.

To do that, please go to SolidPlant Ribbon, and then click at SE Isometric. And zoom it.
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To insert our 3D grid, select Structures Tab-> Structure 3D Grid

When you select 3D grid a dialogue box will appear in feature
manager panel which gives you details about Grid parameter, Grid Point
valve and location of the point we selected.

Select the desired point from where we want to start or create our 3D grid then click 2Get start point®.

After you click @Get Start Point® button you can observe the preview of the 3D grid generated by SolidPlant3D.
Now you can enter your values in Grid Point Value "eld X, Y and Z respectively, 3D Grid will adjust accordingly.

For illustration:
We enter X-axis 5500, Y-axis 5400 and Z axis 3000

To add level just enter the desired value in
grid parameter "eld or use increment or decrement
arrow marks in respective "elds and click on 2+° button
to add a new level or 2-2 to subtract an existing level
and select™°

So the "nal 3D grid will look same as below picture.
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Chapter 5-3 How to place Structure Member on 3D grid
After we placed the 3D grid, we will create or place columns on our grid.
First go to Structure folder in feature tree manager, select the 3D grid frame.

Select@lnsert Structure member® function in Structure tab.

You can notice that Structural member selection window will appear in feature tree manager panel.
Please observe that there are few columns in selections tab i.e. Standards, Type, Size and Groups.

Standards refers to the di#erent types of standards we use in steel structure. If you click on the drop down button
you can see di#erent types of standard i.e. ANSI, DIN, JIS, ISO and many more.

For lllustration: Select ANSI in standard, then we can select any type of steel structure in type "eld. We will selec
a\W section® for this grid and select size as W8X40.

Select the ground $oor vertical columns as one group and "rst $oor vertical columns as another. Same as shown
in the below picture and click °
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Next, we will place beams. Click Structure Tab 2Draw Structure Member®

The concept of placing beams is to make a point-to-point sketch, from starting to end point. Then Exit Sketch

When you exit sketch, the dialog of Structure Database will pop up. Select the ANSI standard from standards
choose W section® from member group and choose the size 3W8x24° from member size click 20K

Now we got beams. Please notice that beams are currently placed by di#erent angle. We can change the positior
of beam. To do that, please expand the assembly of Grid Frame-1. Then select Structural Member of Weldment, and clic
Edit Feature.
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The edit feature for structure member will appear in feature manager, scroll down for Alignment Settings, we can
rotate it by giving the rotation degrees, and also we want to change position or locate pro"le. As we want to place Top of
Steel (TOS) at the top surface of the column, click at Locate Pro"le button select the mid-point of the structural member,
the beams will automatically align to TOS. Clic¥?

Accordingly, we can create as many columns as we want. To reduce the man hours of the designer, if the projec
has too many columns and beams we can use the pattern feature of SolidWorks.

Chapter 5-4 Auto-Trim Feature

When we place the beams on a grid, the structural members will not be trimmed exactly to the corner sections.
SolidPlant3D has a smart feature callefiuto-Trim® which trims the corner edges of the steel beams. So, when we
generate the structural Bill-of-material we will get exact lengths of the beams.

Let's see how to use auto-trim feature:
Go to Structural Tab - > Auto Trim

When you select Auto-Trim feature an Auto-Trim
Dialogue box will appear same as below:

The Concept of Auto-Trim is like setting the priority
of beams which need to be trimmed.

For Example: Have a look at the below picture before
we use auto-trim feature.




mm SolidPlant

Now we select Auto-Trim feature, Select the column and press input button of the 1St body and select the beam
and press input button of the 2nd body as we want to trim the beam exactly with reference to the column.

After you click on Auto-Trim button SolidPlant 3D will trim the excess structure with reference to the column.

_ms

Chapter 5-5 Insert Connections

Insert connection feature helps you in placing the connections between the column and beam like Clip angle,
End plate and sheet plate. We can use this insert connection to show the connection between beams. To activate Inser
Connections: Structure tool tab-> Insert connections.

When you activate Insert connection feature a new dialogue box will appear which is same as below image
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Select the face of the beam and column to insert connection between them, select the faces with holding éctrl®
button and click on the input button in the insert connection dialogue and click next.

In the next screen of the Insert connection you can choose which type of connection you want to place. Click on
the browse type drop down select the clip angle, browse template drop down you can select the di#erent types as of one
we have one type so we select basic angle, you can observe the preview of the connection then click @insert®

SolidPlant 3D will Insert the clip angle connection between the selected structural members.

As Explained in the "rst Chapter, SolidPlant 3D provides you with many smart(er) functionalities especially
structural primitives i.e stairs, ladder, handrail, platform, bracing, $oor plate, walk way, pipe-bridge, conveyor and many
more. Each functionality will be explained in further chapters.
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Chapter 5-6 Stair
This chapter will explain you about how to place or create a stair. Normally to design a stair it requires too many
man-hours but using SolidPlant 3D we can generate a stair within a short matter of time just using a single sketch line.

Let's start creating a new stair, go to structural tab activate stair.

After you select the stair function the application will take in to sketch mode where we have to sketch a line as a
reference to the stair.

Specify the dimension of the line to be 1200. And exit the Sketch.

The dialog of Stair template will pop up, and at the same time, the model preview will be shown. We can modify
our stair as per our requirement. For example: set the Start Platform to be 90 degrees to the left, then verify height and clicl

Apply.
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When you apply the modi“cation you can notice that the model is automatically adjusted to the modi“cations,
verify all the settings and then click Close.

Chapter 5-7 Floor Plate

This chapter will explain you about how to create a $oor plate.

To start creating a $oor plate we need to select a surface as reference on which we suppose to create a plate.
Select face of Beam->Go to Structural tab-> Activate Floor plate

When you click on the $oor plate function the application activates sketch mode with rectangle sketch selected
as default. Click on the corner points of the structural steel frame where we suppose to create the $oor plate same a:
explained in the below picture.

The dialogue of $oor plate will appear at the same time you can see the preview of the $oor plate in the window.
We can select type of plate like Grating, Checker, Threading and Wood. We can $ip the side of the $oor plate if needed the
click 2Apply° and 2Close®.
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Chapter 5-8 Hand Rail

This chapter will teach you how to create the handrails for your structural $oors. Hand rails are very important for any high
rise structure as it provides safety to the people.

Creating hand rails in solidPlant3D is fast and accurate. To start modeling handrail go to structures tab and activate handrali
function.

Structural Tab -> Activate Handrail

After you click on the handrail function the application will take you in to sketch mode where straight line is
selected as default. If you wish you can change the sketch type.
We use straight line for this case, draw the line as speci“ed at the edges of the beam and 2Exit Sketch®.

When you exit sketch, Handrail dialogue will pop up with preview of the handrail in the model window. You can
modify the height of the hand rails, change the number of railing and even adjust the width between railings.

After you close the Hand rail dialogue box you can observe that all the railings are equally spaced between them.
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Chapter 5-9 Ladder
This chapter will teach you how to create a ladder with case.

Go to Structure tab-> Activate Ladder

When you click on the ladder function, it will enter into sketch mode with straight line selected as default. Draw
a line as shown, this will be the reference for our ladder width, then exit sketch.

When you exit sketch, ladder dialogue will pop up with preview of the ladder in the model window. You can
modify the height of the ladder choose whether you want @age® or not.

After you apply the changes verify the ladder to see that everything you changed has been modi"ed or not. Then
close the ladder dialogue box.
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Chapter 5-10 Platform
This chapter will teach you how to create a platform with minimal sketch and time.
Go to structures tab activate @Platform® function.

When you click on the Platform function, it will enter into sketch mode with straight line selected as default. Draw

a line as shown, this will be the reference for our platform length, then exit sketch.

When you exit sketch, platform dialogue will pop up with preview of the platform in the model window. You can
add or remove the handrails from the sides of platform and also add supports for the platform after you modify your chang-

es click 2Apply®.

-rm

After you add your desired handrails and supports, verify in the 3d model and close the platform template window.




mm SolidPlant

Chapter 5-11 Footing
This chapter will teach you about footing for structural beams and Equipment. SolidPlant3D will generate footing
with just a point as reference within a short matter of time.

Let's see how to generate footing for columns. To activate footing feature go to structure tab click on 2Footing® function.

When you click on the footing function, it will enter into sketch mode with point selected as default. Draw a point
as shown, this will be the reference for our footing then exit sketch.

When you exit sketch, the footing dialogue will pop up with preview of the footing in the model window. You can
change the shape of the footing from simple to circular, hexagon and octagon, you can change the dimension of footing
and also can set the footing as below ground level. After you modify your changes click 2Apply° and 2Close® footing
template window.
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Chapter 5-12 Pipe Bridge
This chapter shows you how to create Pipe Bridge in your project. SolidPlant 3D provides you a very smar
functionality which is pipe bridge that can be generated within a fraction of seconds with just a single sketch.

To create Pipe bridge go to structure tab click on the Pipe-Bridge feature.

When you click on the Pipe-Bridge function, it will enter into sketch mode with straight line selected as default.
Draw a line as shown, this will be the reference for our pipe-Bridge, then exit sketch.

When you exit the sketch, Pipe-Bridge dialogue will pop up with preview of the Pipe-Bridge in the model
window. You can modify the dimensions like height the Pipe-Bridge, width of the columns, size of the column and height
of the tier. After you entered your desired dimensions click Apply and Close the dialog.

Your Pipe-Bridge is created with all your desired dimensions within a short matter of time.
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Chapter 5-13 Walk Way

This chapter shows you how to create a Walk Way in your project. SolidPlant 3D provides you again smar
functionality which is; walk way. This is to provide accessibility between the high rise Tanks and structures, that can be
generated within a fraction of seconds with just
a single sketch.

To create Walk Way go to Structure tab click on
the Walk Way feature.

When you click on the Walkway feature, it will enter into sketch mode with straight line selected as default. Draw
a line as shown, this will be the reference for our Walkway, then exit sketch.

When you exit the sketch, Walkway dialogue will pop up with preview of the Walkway in the model window. You
can modify the dimensions like length & width of the walkway and height of the handrail. After you entered your desired
dimensions click Apply and Close the dialog.
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Chapter 5-14 How to Generate Part list of Structural Members
This chapter will explain you how to generate a Part list for our Structural Members. To generate a Part list "rst we
have to open our grid frame in its own window to do so, select the grid frame and select open part.

Grid frame will be opened in its own window. From the feature manager select the cut list right-click and update.

After you select the update, the entire Cut list will be updated. To generate this Cut list in to a report format you
should go to the structural tab and click on Assign member Tag feature.

When you select the Assign Member TAG feature, Assign member dialogue will pop up; in here you can observe
all the information like Density, Volume, surface area and Mass of our structural members and also you can notice the
length and description of the Structural beams and columns of the grid frame. We can change the name of the Columns
and beams. For instance lets change the columns to CO and Beams to BE respectively as shown in the below Image a
Apply the changes.
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When you apply the changes, Member
Tag list dialogue (box) will pop up with the changes
we made to the names for columns and beams.
You can export this list into excel by just clicking
on the Export to Excel button.

Part List will be exported into an excel "le
instantly when you click on the Export to excel button
with all the summary like Mass Properties, center of
mass and Total length of the structural members.

Chapter 6 Create Equipment Model

Chapter 6-1 Equipment

Equipment creation plays a very vital role in Plant Design. Creating or modeling an equipment takes many
man-hours for a general user. Using SolidPlant you can create any type of equipment very quickly and accurately using the
smarter functionalities provided by SolidPlant.

This chapter will explain you how to create equipment. SolidPlant is built-in with a standard library of equipment,
which include various types of tanks, pumps, vessels, and exchangers. The advantage of having a standard library is that v
can input data and values such as height and all other dimensions very quickly.
An opening for an Equipment is known as Nozzle. A Nozzle is considered an important part for an equipment as it will be ¢
reference for pipe routing.

Equipment models can be created using SolidWorks, if any of the 3D models is created in SolidWorks or evel
outside SolidWorks (meaning; other 3D CAD packages) can be imported into SolidPlant Project using @Convert Equipment
function.

Let's see in detail how we work with the above functions.
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Chapter 6-2 Create Equipment model from standard library

Let's see which equipment templates are already available in the SolidPlant Library. Go to 2Equipment® tab click
on 2Create Equipment® function then a dialogue (box) will appear. Click on the drop down to pick dilerent categories of
equipment. Equipment is categorized into dilerent types i.e.

t )FBU &YDIBOHFS
t IVNQ

t 4UPSBHF 5BOL

t 7TETTEM

t . JTDFMMBOFPVT
t SVTUPN

Select a category that you want and you will observe which type of templates are readily available select a template, you
can also have a look at the preview of the template.

Chapter 6-3 Pump
SolidPlant Equipment library contains dilerent types of Pumps under pump category.

Chapter 6-4 How to Create the Horizontal Pump.

51JT DIBQUFS XJMM UFBDI ZPV IPX UP DSFBUF B )PSJ[POUBM QVNQ X
GPS UIF QVNQ DBO CF DSFBUFE JO UXP XBZT BT BMSFBEZ FYQMBJOFE JC
NBOBHFS JJ +VTU HIJWF B 5BH XIFO ZPV DSFBUF BO FRVJQNFOU 5I1JT DI
earlier.
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Go to Equipment tab-> Create Equipment-> Pick Pump category from the drop down-> select horizontal centrifugal pump.

USJGVHBM 1VNQ

5P DSFBUF B 5BH GPS UIF 1VNQ DMJDL PO UIF i5"(w UBC PO UIF DSFB
JO UIF UBH 6FME PS ZPV [[ 3p DMJDL PO UIJT CVUUPO UP PQFO 5BH

/IPX FOUFS B 5"( zZPV DBO BMTP HJWF UIF EFTDSJQUJPO PG UIF FR
equipment and click areate® button.

'"FFE 8BUFS 1VNQ

When you click on the create button you can observe
UIBU 5BH JT SFHJTUFSFE JO UIF QSPKFDU EBUBCBTF 6 DBO TFF UIF
summary in create equipment dialog.

/IPX 1JU i$SFBUFw CVUUPO JO UIF DSFBUF FRVJQNFOU EJBMPHVF UP DSFB
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8IFO ZPV DMJDL PO UIF $SFBUF CVUUPO B % QVNQ UFNQMBUF XJMM
BMM UIF EJNFOTJPOT TIPXO :PV DBO NPEJGZ UIF EJNFOTJPOT BT EFTJSFE
the dimension into the system by adding to favorite.

5P BEE UP GBWPSJUF FOlE]S B OBNF BOE DMJDL PO CVUUPO
GBWPSJUF ESPQ EPXO NFOV $MJDL i"QQMZw CVUUPO UP FNCFE UIF DIBOH

PV DBO PCTFSWF UIF E NPEFM XJMM CF DIBOHFE XJUIl SFTQFDUJWF UP 1

"GUFS ZPV DMPTF UIF QVNQ EJNFOTJPO EJBMPH ZPV DBO PCTFSWF
that is because we have not set the nozzles with size, spec and "ange type.

:PV DBO PCTFSWF UIF /P[[MF DPNQPOFOU XJOEPX JO UIF GFBUVSF
default.

IMFBTF IBWF B MPPL BU UIF NPEFM UIF OP[[MF OVNCFST IBWF CFF!
taken as N1 and discharge is taken as N2 with equipment tag.

Now, we have to assign the size, spec and "ange type to the nozzle; to do so pick the nozzle number from the
drop down.
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Pick second or discharge nozzle from the drop down and change the size to 49 select the nozzle type? thiek £lose
the window, save the changes when prompted.

"GUFS DMPTJOH UIF QVNQ XJOEPX ZPV XJMM CF SFEJSFDUFE UP NBJ

PO UIF SJHIU TJEF DMJDL PO UIF 3FGSFTI 5BH CVUUPO UP TFF UIF 1VNC
group.

PV DBO BMTP TFF UIF QSFWJFX PG UIF FRVJQNFOU BU UIF EPXO PG EPDV

FOU MJTU

BH CVUUPO

Placing the equipment into the layout will be explained in the further chapters.

Chapter 6-5 How to Create the Horizontal Vessel.
51JT DIBQUFS XJMM UFBDI ZzPV IPX UP DSFBUF )PSJ[POUBM 7FTTFM XIJDI J

(P UP &RVIJQNFOU UBC $SFBUF &RVJQNFOU 1JDL 7FTTFM DBUFHPSZ GSF

GSPN UIF ESPQ EPXO

TFM
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-FU T DSFBUF B 5BH GPS UIF WFTTFM UIJT UJNF XF FOUFS UIF i5"(w
B TVNNBSZ XJMM CF I[JHIMJHIUFE BVUPNBUJDBMMZ FOUFS UIF EFTDSJQU.
% NPEFM PG WFTTFM

$SFBUF CVUUPO UP DSFBUF UIF

JO EFTDSJQUJPO
OUFS 7FTTFM

8IFO ZzPV DMJDL PO UIF $SFBUF CVUUPO B % WFTTFM UFNQMBUF XJI
BMM UIF EJNFOTJPOT TIPXO :PV DBO NPEJGZ UIF EJNFOTJPOT BT EFTJSFE

the dimension into the system by adding to favorite.

5P BEE UP GBWPSJUF FOlE]S B OBNF BOE DMJDL PO
GBWPSJUF ESPQ EPXO NFOV $MJDL i"QQMZw CVUUPO UP FNCFE UIF DIBOH

CVUUPO

:PV DBO PCTFSWF UIF E NPEFM XJMM CF DIBOHFE XJUI
respect to the dimensions.

aClose® the dialog.

"GUFS ZPV DMPTF UIF WFTTFM EJNFOTJPO EJBMPH CPY VOMJLF B

the model so, we have to de#ne by ourselves.

5P DSFBUF B OP[[MF GPS TVDI UZQF PG FRVJQNFOU ZPV IBWF UP V

Equipment tab. When you click on the equipment nozzle function, the Nozzle component dialog will appear in the feature
manager tree with nozzle data tab selected as default.
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/PX DMJDL PO UIF UBH ESPQ EPXO ZPV XJMM TFF OPUIJOH JO JU BT
UIF OP[[MF EBUB DMJDL&PO UIF /FX /P[[MF CVUUPO B 5BH QSPQFSUZ
i7 / w FOUFS EFTDSJQUJPO JG ZPV IBWF BOE TFMFDU ZPVS EFTJSFE TF¢
can select the color by spec, service, custom and
Nominal diameter, color will change accordingly.
Click 2Create® button.

"GUFS ZPV DMJDL PO UIF DSFBUF CVUUPO QMFBTF PCTFSWF UIF OP]|
will set accordingly, change end type to "ange and select Non-standard 150LB Raised face nozzle type.

5P QMBDF UIF OP[[MF PO UIF FRVIJQNFOU DMJDL PO UIF 1PTJUJPOT |
be created on the equipment surface. Give angle and distance if needed, click apply and 8fitkén close the window,
save the changes when prompted.

BODF JG SFRVJSFE

"GUFS DMPTJOH UIF WFTTFM XJOEPX ZPV XJMM CF SFEJSFDUFE UP N
PO UIF SJHIU TJEZ DMJDL PO UIF 3FGSFTI 5BH CVUUPO UP TFF UIF 7

group.

:PV DBO BMTP TFF UIF QSFWJFX PG UIF FRVJQNFOU
at the lower end of the document list when you
TFMFDU UIF 5BH

NFOU MJTU

5BH CVUUPO

BEEFE UP UIF
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Chapter 6-6 Add Elevations to the project.

Generally Plant layouts consist of few elevations where di$erent types of equipment will be located depending
PO UIF XPSLJOH DPOEJUJPOT &MFWBUJPOT NBZ CF OBNFE BT HSPVOE @gPF
ZPV UIF QPTTJCJIJMJUZ UP BEE UIF FMFWBUJPOT UP UIF QSPKFDU TP UIBL
equipment exactly to a speci#c "oor.

5P BEE FMFWBUJPO UP UIF DVSSFOU QSPKFDU
QMFBTF HP UP 4PMJE1MBOU UPPMCBS DMJDL PO "EE
&MFWBUJPO UP UIF DVSSFOU 1SPKFDU GVODUJPO

U 5PPMCBS

FWBUJPO UP UIF
DU

8IFO ZzPV DMJDL PO UIF "EE FMFWBUJPO GFBUVSF i%F8OF -FWFM G
NBOBHFS USFF &OUFS ZPVS EFTJSFE EJNFOTJPO GPS FBDI MFWFM BOE DN
UP UIF QSPKFDU

POT UP UIF QSPKFDU

"GUFS ZzPV DMPTF UIF BEE FMFWBUJPO EJBMPHVF
you can observe in the feature manager tree that

Elevation folder is added with the elevation speci#ed

GPS UIF QSPKFDU

Chapter 6-7 Insert Equipment into the Layout.

51JT DIBQUFS XJMM UFBDI ZPV IPX UP JOTFSU UIF FRVJQNFOU JO U
equipment we need in our plant with nozzles we can insert them into the plant layout.

Let's see how to insert a Pump in the layout, select the pump from the document list for example we have
‘81 VOEFS UIF FRVIJQNFOU DBUFHPSZ %SBH UIF QVNQ CZ VTJOH iNJEE
you drop the pump in the layout the application will prompt for elevation selection with a small pop up dialogue, select
X1JDI FMFWBUJPO ZPV XBOU UP TOBQ UIF QVNQ 'PS FYBNQMF * XBOU U
Plane%0° and hit &lose®

ESPQ UIF NPEFM
PG UIF .PVTF
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"GUFS ZPV DMPTF UIF NBUF EJBMPH CPY UIF QVNQ XJMM CF TOBQQFE UP
/IPUF QVNQ NBZ CF TOBQQFE BOZXIFSF JO UIF MBZPVU TPNFUJNFT NBZ CF
"DDPSEJOH UP UIF MBZPVU UIF QVNQ TIPVME CF QMBDFE JO UIF NBSLFE M
UIF TQFDJ6D MPDBUJPO XF DBO VTF 4PMJESPSLT NBUF GFBUVSF PS XF DB
51JT UVUPSJBM XJMM UFBDI ZPV IPX UP VUJMJ[F UIF 4PMJE1IMBOU GFBUVS

.PWF GVODUJPO 5P BDUJWBUF UIF .PWF GVODUJPO HP UP &RVJQNI
move/rotate component dialogue will appear in feature manager tree. Select pump as component to move.

.PWF UZQF .PWF UP &0OUJUZ
Select a point on the edge of the pump as shown in the below picture which will be the reference point for the pump to

move to the destination.

OUw GFBUVSF

Now select the destination point in the layout where the pump should be actually located.

51FO 1JU i"QQMZw :PV DBO TFF UIF QVNQ NPEFM XJMM CF QMBDFE BU UIF

"T ZPV DBO TFF UIF QVNQ NPEFM JT OPU QMBDFE BT XF SFRVJSFE 5|

exactly in the space allocated for the pump.
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-FU T VTF SPUBUF GFBUVSF UP SPUBUF UIF QVNQ 5P BDUJWBUF UIF
PO UIF UPPMCBS PS KVTU DMJDL PO UIF i3PUBUFw ESPQ EPXO JO UIF GFB
enter the angle.

51FO 1JU i"QQMZw :PV DBO TFF UIF QVNQ NPEFM XJMM CF SPUBUFE BOE Q!

Chapter 6.8 Create Pattern of the Equipment.

.PTU PG UIF UIJNF JO EFTJHOJOH B 1MBOU UIFSF XJMM CF NVMUJQNM
FRVIJQNFOU 'PS FYBNQMF JO UIJT UVUPSJBM XF OFFE B QVNQ XIJDI JT TB
the equipment using SolidPlant features.

Pattern of equipment is of two types (i) Linear Pattern (ii) Circular Pattern.
J -JOFBS 1BUUFSO DSFBUFT QBUUFSO JO TUSBJHIU MJOF QBSBM
JJ $JSDVMBS 1BUUFSO DSFBUFT QBUUFSO JO DJSDVMBS GPSN

*G ZPV PCTFSWF UIF MBZPVU XF IBWF B QVNQ '81 CFTJEF UIF QVN
a linear pattern please click on the 2Linear Equipment® feature in Equipment tab.

(P UP &RVJQNFOU UBC BDUJWBUF -JOFBS FRVJQNFOU GFBUVSF 5
feature manager tree. Select the direction of the pattern on the pump ("ip the direction if required), enter the distance
CFUXFFO UXP QVNQT BOE OVNCFS PG DPQJFT ZPV SFRVJSF 4FMFDU UIF
preview of the pattern equipment

RVJQNFOUw
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Check whether your required equipment is matching
with pattern. If everything OK then click on the9®

8IFO ZzPV BDDFQU UIF QBUUFSO 5BH BTTJHONFOU
EJBMPHVF XJMM QPQ VQ BVUPNBUJDBMMZ 51JT XJMM BTTJHO

the tag for your newly patterned equipment.
51JT XJMM SFEVDF UIF FSSPS JO BTTJHOJOH PS NJTTJOH UIF

EBUB &OUFS UIF 5BH BT '81 DMJDL iO,w

‘81

"GUFS zPV DMJDL 0, UIF NPEFM XJMM CF SFHFOFSBUFE

automatically and the pump will be accepted and
UBH XJMM CF VQEBUFE 5P BQQFBS JO UIF EPDVNFOU MJTU

please click on the refresh tag button.

Chapter 6.9 How to convert SolidWorks model to SolidPlant Project.
"1MBOU DPOTJTUT PG i/lw OVNCFS PG FRVJQNFOU JO XIJDI NPTU PG

FRVJQNFOU MJCSBSZ TPNF QSPKFDUT NBZ SFRVJSF B TQFDJBM LJOE PG
*O PSEFS UP VTF UIJT TQFDJBM LJOE PG FRVIJQNFOU

% BQQMJIDBUJPO
VTJOH UIJT GVODUJPO ZPV DBO DPOWFSU UIF FRVIJQNFOU BOE VTF JO ZP\

-FU T IBWF B MPPL BU IPX UP DPOWFSU 4PMJESPSLT NPEFM UP 4PMJE1MBC
#le selection dialogue will popup browse to the location where you placeddyou're 3

SolidWorks #rst. Click on20Ope| /%
model, select and click on open.
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"GUFS ZPV DMJDL PO UIF PQFO CVUUPO UIF E NPEFM XJMM PQFO J(
PO iSPOWFSU &RVJQNFOUw GFBUVSF UIFO B 5BH 1SPQFSUZ EJBMPHVF XJM
and click on 2Create® button.

8IFO zPV DMJDL PO UIF DSFBUF CVUUPO UIF QVNQ XJMM CF DPOWEF¢
the pumps. Our 3d model is already having nozzles in order to convert these nozzles into SolidPlant we need to de#ne
them with spec and size to do so. Go to Equipment tab-> click on 2Equipment nozzle® then nozzle component will appear
in feature manager tree.

/IPX DMJDL PO /*K /P[[MF CVUUPO B 5BH QSPQFSUZ EJBMPH
i'81l / w FOUFS EFTDSJQUJPO JG ZPV IBWF TFMFDU ZPVS EFTJSFE TFSW
can select the color by spec, service, custom and Nominal diameter, color will change accordingly. Click @Create® button.

"GUFS zPV DMJDL PO UIF DSFBUF CVUUPO QMFBTF PCTFSWF UIBU B
accordingly, change end type to "ange and select Non-standard 150LB Raised face nozzle type.

G 6TFS /P[[MF
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Now click on the positions tab, select the edge line of the nozzle then you will see a centerline passing from the
middle of the nozzle, use "ip if required.

5P EF6OF UIF TFDPOE OP[[M¥% DMJDL PO /FX /IP[[MF CVUUPO B &
QSF EFO6OFE BT i'81 / w FOUFS EFTDSJQUJPO JG ZPV IBWF TFMFDU ZPV!
you want you can select the color by spec, service, custom and Nominal diameter, color will change accordingly. Clicl
aCreate® button.

"GUFS zPV DMJDL PO UIF DSFBUF CVUUPO QMFBTF PCTFSWF UIBU B
accordingly, check the usernozzle check box and select Non-standard 300LB Raised face nozzle type.

G 6TFS /P[[MF

Now click on the positions tab, select the edge line of the nozzle then you will see a centerline passing from the
middle of the nozzle, use "ip if required.
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Click the 29° to accept the user nozzles.

Close the equipment window, save the
changes when prompted. Refresh the document
list to see the equipment tag and insert into the
layout as explained before.

Chapter 7 Routing

Chapter 7-1 Routing
51JT DIBQUFS XJMM UFBDI ZPV BCPVU 3PVUJOH 5FDIOJRVFT JO 4P M.
IMBOU %FTJHO 3PVUJOH B QJQF GSPN TUBSU UP FOE QPJOU SFRVJSFT
#ttings and shorter distance. In order to accommodate these requirements SolidPlant has come up with a smarter Idea ol
routing known as 2Smart Route®
1JQJOH %FTJHO PS 3PVUJOH JO 4PMJE1IMBOU % JT DBUFHPSJ[FE JOUP U.
t .BOVBM 3PVUF
t "VUP 3PVUF
t 4ANBSU 3PVUF
Let's learn brie"y about these 3 routing modules. We will work individually in the further lessons.
Manual Route: 51JT JT UIF QPJOU UP QPJOU SPVUJOH XIFSF VTFS IBT UP

Auto Route: 51JT GFBUVSF JT WFSZ IBOEZ GPS B 1JQJOH EFTJHOFS B8IFS
end point of the route, in most cases it will be nozzles of the equipment.

Smart Route: * WFSZ 60JRVF BOE 1IFOPNFOBM 'FBUVSF XIJDI XJMM CF WEF
ful#lls the motto of SolidPlant 2Route it your Way® Smart Route is a feature that fetches the information of a line list from
UIF EBUB ZPV IBWF JNQPSUFE FBSMJFS VTJOH 5BH NBOBHFS UIFO HFOFS
#ttings like valves, control valves and strainer etc.

Chapter 7-2 How to de#ne a New Pipe Model
51F WFSZ JNQPSUBOU UBTL JO EF60OJOH B OFX QJQF SPVUF JT UP EF
B QJQF JO 4PMJE1MBOU %F60OJOH UBH JT PG UXP UZQFT J *NQPSU 1 *%

Chapter 7-3 Create the tag of pipe routing using Import P&ID data

*NQPSU 1 *% EBUB JT PG UXP UZQFT J JG ZPV SF VTJOH 4PMJE1
4PJME1MBOU % XJUI KVTU B TIJIOHMF DMJDL VTJOH B QIFOPNFOBM GFBUV
FSSPS JO JNQPSUJOH UIF 1 *% EBUB JJ *G ZPV IBWF EFTJHOFE ZPV SF
FYDFM GPSNBU TP UIBU XF DBO JNQPSU BMM UIF EBUB JOUP 4PMJE1MBOU
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Once you import the P&ID data all the tag numbers of pipes will appear in document list under Pipe Routing group.

Now click on the SolidPlant Pipe Routing task pane, observe Active route !'eld you can see nothing in the active
route column. We need to set the property for pipe line and choose the color for each and every line.

Now click on the new pipe mode| |  icon a Tag property dialogue box will pop-up. Pick 8LO100° from the Tag drop down

When you select the line number from the tag drop down, all the information of the line will be updated in the
lelds respectively. Now look at the 2Color By®° leld pick 2service® from the list, the color of the pipe will be changed to yellow
color, click Apply.
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When you click on apply button an information dialogue box will pop-up saying the line already exists, click OK
to update. Click OK and the line will be activated.

Now click on the new pipe mode| ) icon a Tag property dialogue box will pop-up. Pick2L0O101° from the Tag drop down

When you select the line number from the tag drop down, all the information of the line will be updated in the
"elds respectively. Now look at the @Color By° "eld pick 2Nominal Diameter® from the list, the color of the pipe will change
to red color, click Apply.

When you click on apply button an information dialogue box will pop-up saying the line already exists, click OK
to update. Click OK the line will be activated.

In the same manner you need to update all the lines, you may select any di#erent color by selecting the @Custom°
in the color by "eld and select you're desired color.
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Chapter 7-4 Create Tag by Manual input

Now let's learn how to create TAG by manual input. If we require an additional pipe line which is not in P&ID or
P&ID data, we can create manually. Click on the New Pipe model icon, Tag property dialogue box will pop-up. Ente
aLine001°in the tag "eld, description as2New line9, pick a service, spec, main size and also color and click on 2Create® butto

When you click on create, the line number will be created e:i actidated.

Chapter 7-5 Pipe route using Manual Route
Manual Route is also known as Traditional Routing, this is the point-to-point routing, where user has to specify
the routing direction manually.

Let's start manual route using the line number 8L0102° Select the line number from document list right click
select property. In tag property please notice that, from and to columns this should be updated with the nozzles of which
the line is connected to. Normally it will be updated from the P&ID data, if not you have to do manually.

Now click on the SolidPlant Pipe routing task pane from the 2Active Route® drop down select 23LO102° you will be
redirected into edit mode, where you can see the red arrow marks for the line(start and end point). Click on the 2Routing®
tab then select®Manual Route®
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When you click on the manual route you will be redirected into sketch mode where you can start routing your line
from start point to end point. While routing you can see the preview of the 3D pipe, use tab button to toggle between axis
(X, Y and Z). If you think that your route needs to be edited before it generate click on the 2Disable Routing Mode®. Adc
relations, move the sketch line% all these you can do after you disable routing mode.

After you select the disable route mode check box, exit the sketch. As you can observe the route line between f
and g is sloped, we want to make it perpendicular to the nozzle. Select the line add relation 2Along Z° The line will be
adjusted automatically.

Adjust the route as needed. Now uncheck the disable routing mode wait for the select component dialogue
boxes, you need to select the perfect component which suits your needs with respect to rating or schedule.

In the same manner select the rating or schedule for bolt and pipe.
Exit the sketch and exit edit assembly, you can now see the fully created realistic 3D model of LO102 with bolts, $anges an
elbows.
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Exit edit assembly

Chapter 7-6 Pipe Route using Auto Route
This will help the designer design best path or pipe route faster than ever. Just 2 clicks (from and to) mostly at the

nozzle. Then let the system automate pipe routing for you based on the piping speci'cations database we have in the
system.

Select line 2L0101° from the active route drop down, select 2Auto route® from the routing tab.

Select the edge of the nozzle on the vessel
V-101 and select the edge of the nozzle on the pump
aFWP-123°you can observe the route line automated
for you. You can modify the line as needed just by
dragging. If needed you can reverse the $ow of the
line by selecting reverse in the options.

Change the route line to the best suitable
or best accessible way to minimize the material just
by clicking on the arrows on the line. Sometimes
you can observe that line is "xed to some length,
don't worry we have a solution we can change the
length of the pipe using 8Assign Lengthe feature
which will be explained in further lessons.
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Select desired rating or schedule from the select component dialogue box like pipe, $ange, elbow and bolts.

Exit sketch line 23LO101° will be created.

Chapter 7-7 Pipe Route using Smart Route

A unique feature called 23Smart Routing® allows you to create a pipeline with amazing ease. Simply right-click the
pipe tag in the SolidPlant project manager and select2SmartRoute® SolidPlant will then generate the route, connecting the
correct nozzles as de"ned in the data imported from your P&ID design. It will also pop up the valve list for the route based
on that data. You can then easily drag and drop the valves onto the pipeline in the correct location.

Let's route 8LO100° using Smart route feature. Select LO100 from the document list in SolidPlant project managel
right-click and select 23SmartRoute®

_0

When you select the smartroute feature you can observe the automated route line with 3&on"rm smart route®
dialogue box. Click on2Yes®to accept the route or click @No° to display smart route interface.




mm SolidPlant

Let's say we want to change the route line. Click 2No° you can now observe the interface of the Smart route.

You can notice on the interface of smart route there will be start with,
end with information.

Alternative means SolidPlant3D will route in alternative directions for
the same line in 8 di#terent routes. Click on the next button in alternative
you can observe the change in the route line.

Select your desired route, if needed modify the lengths and elevations
just by dragging the sketch line.

I have selected the 7th alternative route, you can observe the change in route line.

As a Piping designer you already know that in plant design there will be two pumps (i) main pump (ii) stand-by
pump. So let's connect the second pump with this same route. Select the straight line and draw a line from nozzle and

connect to the route.

3D pipe will be generated, select bolts from the select component dialogue box, select the rating for Tee from
select component dialogue box.
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Our 3D route will be generated with all the elbows, tees, $anges and bolts. You can observe a smart component
dialogue box will pop up, these are the components which are in-line components for the route line whose data is from the
P&ID import. This is an extraordinary way to add the values in a route line to minimize the errors.

Now drag the valve(middle button of mouse) from the add valve dialogue box and drop on the line, an Insert
point dialogue box will pop up this is giving the reference point for the valve, select start point (you can notice the selection
point will vary depends on start and end point).

After you click on apply button, select component dialogue box will pop up, select the type and rating of the
valve (double-click on the valve or click on Create button).

The model will be reloaded and updated with the realistic valve model at the start point with $anges and bolts.




mm SolidPlant

Select the second valve and drop on the line and select the type and rating of the valve same as above then Exit sketch.

Thus, Smart Route is a phenomenal feature for designers.

Chapter 7-8 Smart Fitting
SolidPlant3D has a cool feature called Smart Fitting that allows you to extend or add pipe branches by dragging

any point you like on the pipe. This feature will automatically put the "tting on. If it's an extending pipe, the "tting will
change.

Let's have a look at the smart "tting functionality. For example we have a line which is having elbow.

Select the line001 from the active route drop down, select manual route and draw a line from the elbow as if it is a branch.

Intelligently Solidplant3D will change the "tting in this case elbow will be updated to the @Tee® component
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Like this, you can draw as many branches you need smart "tting will execute in just a fraction of a second.

Chapter 7-9 Assign Length
Let's learn how to assign length for a pipe. As you already saw from the above lesson, sometimes our route line

will be "xed with some constrains, changing the length of the pipe will come in handy or in some cases we need to assign
the exact length of the pipe from the nozzle.

Select the route line which you want to assign the length, edit assembly, and select the sketch or just double-click
on the line, go to Routing tab and click on the @Assign Lengthe feature.

Assign pipe length dialogue box will pop-up you can observe the length of the pipe line, now change the length
to 500 and click 8Apply°
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Chapter 7-10 Elevation Move Pipe

Let's learn how to move the pipe using 2Elevation Move Pipe® feature. In some cases we need to have a speci'
distance from structural columns or beams. In the case of Pipe-bridge all the bottom of pipe (BOP) should be resting on the
same structural steel, at that moment Elevation Move pipe feature will be handy. For example: we give one pipe as
reference and select all the pipes to be set as the reference.

Now, we set the distance of the pipe from the structural column.

As you can observe from the below picture the distance between column and pipe is very far so we will set the distance
between them.

Double-click the line to edit the sketch, go to Routing tab, select 2Elevation Move Pipe® feature.

Pipe elevation dialogue box will appear in feature manager tree, select the pipe line as reference, select column
as target reference, select the point of the pipe and give the distance to move.

The whole route line will move accordingly, Exit the sketch when you done.
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Chapter 8 Insert Piping Components

Chapter 8-1 Piping Components

This chapter will teach you about Inserting Piping Components in SolidPlant3D. After you route a Pipe line the
next important thing is to add components like Valves, Control Valves, Strainer, and Olets etc... SolidPlant3D provides sma
features to insert Piping components. You can insert any component just by selecting point on the route line. In this
chapter we will also discuss about Pipe supports.

Chapter 8-2 Insert Valve
We already saw the Smart Route feature, where valves will be prompted while routing itself. If we route a line
using Manual or Auto Route, we need to insert the valves manually. Let's see how to insert valve on a route line.

Double-click on the line to enter edit sketch mode, select a point you want to add the valve, go to @Component Tab® click
on the valve feature.

When you activate the valve feature, 2Valve Tag® dialogue box will pop-up, input the tag for valve add a descrip-
tion (optional) select the insertion point i.e main point, center point and run point, these points are the reference points for
the valve which will be inserted into the line at the selected reference point.

Select Component for valve will pop up, select the rating, type of valve and type of end connection and click on
aCreate®

Select type of bolts. Then valve will be inserted into the location you selected.

Exit the sketch.
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Chapter 8-3 Insert Pipe Support

Pipe supports play a very important role in the piping design. Placing a pipe support requires a wise decision.
SolidPlant3D provides di"erent types of pipe support in a user-friendly interface.
To place a Pipe-support double-click the line to enter edit mode, go to Routing tab and click on@Pipe Support®feature then
Available Pipe Support dialogue box will pop-up.

You can notice all the available Pipe supports will be visible for you in the Interface. Select one type and drag
using middle button of mouse just nearby to the line, pipe support will snap automatically and tag will be assigned.

When you click Next button we can observe
the 2Edit Pipe support® dialogue box in this you can
edit the support characteristics like angle, length
and reference point for 0"set. In some cases if you
want to extend the support to the base you can give
that face as reference face.

In the same manner you can insert any number of pipe support on your route line. After you #nish placing the
support close the pipe support dialogue box, exit sketch and exit assembly.
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Chapter 8-4 Insert Reducing Tee
Let's see how to insert reducing tee, as you can observe; smart #tting means changing one #tting to another with

same size. In some cases we require reducing tee, to place a reducing tee you need to activate the route line by selectin
from the active route drop down then change the pipe size.

Esc from the straight line function, then you will notice select component dialogue box will appear to select the
exact size and rating for reducing tee. Select you're desired reducing tee and click on create.

Reducing tee will be created with the speci#ed spec and rating, Exit the sketch and assembly.

Chapter 8-5 Insert Olet
Olet is a Piping component generally used to insert for smaller size of pipe into a large size of pipe. Normally olets

are used for connecting or inserting vents and drains for a pipe line.

Let's insert a $ inch olet into a 6 inch route line. Double-click the line to edit, change the pipe size to $ inch, go
to component tab, select 20let® feature.
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After you select Olet feature you will be redirected into sketch mode, draw a straight line connecting from the
main line as a tapping. Select component dialogue box will appear to select the exact Olet. Select the Olet and click ®create

After you click the create button, The olet will be created. Exit the sketch and exit assembly.

Chapter 9 Review and Manipulation Features

Chapter 9-1 Review Features
This chapter will teach you about Review features in SolidPlant3D. Check or review the component information
is essential in plant design. Let's have a look at the review feature that is also known as Component Property.

Chapter 9-2 Component Property
To review the information of the component or to verify the component property this feature will be handy.
Select a component for example ;ball valve in the route line 3LO101° then go to 2Routing® tab select component property.
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Then Component Property dialogue box will pop up
with all the information of the valve displayed in one
single interface.

You can also change the component like elbow and
click refresh on the component property dialogue
box. All the information will be shown for elbow.

Let's see the properties for a lange, select the !lange
and click on @refresh® button.

Chapter 9-3 Manipulation Features

Manipulation is a must in plant design, most of the time in designing we try to manipulate the route lines. To
reduce the designer time and e"ort, SolidPlant3D come up with di"erent types of manipulation features such as 2Assign
Length® 2Rotate Component?, 2Delete Component®, 2Rebuild Component® and many more.

Chapter 9-4 Rotate Component

Rotating a component like eccentric reducer
and operator of the valve is an important task in the
piping design. Pumps may fail if we place the eccentric
reducer in the wrong direction. In such cases 2Rotate
Component® feature comes in handy.

For example | want to rotate the operator of this valve
to 90 degrees.
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Select the valve operator, go to 2Routing® tab, select 2Rotate Component® feature. Then rotate component
dialogue will pop up, select the degrees from the drop down and click 2Rotate®

After you rotate to your desired degrees, close the dialogue box.

Chapter 9-5 Delete Component.
Sometimes in plant design we need to delete a component without changing the route line. In such cases2Delete
Component® feature will come in handy.

For example | want to delete the reducer.

Double-click to edit the line, select the point of the reducer, go to 2Routing® tab, and select Delete Component feature.

After you click on the @delete componentS, the reducer will be deleted. Exit the sketch and exit the assembly.
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Chapter 9-6 Rebuild Component.

If in any case you deleted the component which should be needed in the route line, no need to worry.
SolidPlant3D have a phenomenal feature known as 2Rebuild Component® which will rebuild the same component with
same spec, rating and end condition.

For example we have deleted the elbow from a line.

Don't worry, just select the end point, go to 2Routing® tab, and click on 2Rebuild Component® feature. The route
line will be regenerated with the elbow.

Elbow will be added automatically.

Chapter 10 Pipe Routing Advanced Features

Chapter 10-1 Pipe Routing Advanced Features.
SolidPlant3D provides many Smart and Intelligent features which help in designing a Plant much faster, more
accurate and simple. Some of the advanced routing features are (i) Change size of the route (ii) Jog Route and (iii) Split Pif

Chapter 10-2 Change size of the route line.

A route line consists of di"erent sizes of pipes, for example when you're designing a control station the control
valve should be smaller in size compared to the main run size, at this point we will add two reducers at both ends of the
pipe but SolidPlant3D has an extraordinary feature known as 2Change size® When you make use of this feature, the reduct
will be added automatically.




== SolidrPlant

Let's have a look at the @Change Size® feature. Please have a look at the below picture: we want to change the si:
of this line.

Double-click the line to activate edit mode. Select the line that you want to change, go to 2Routing® tab click on
a8Change Size° feature.

Change size dialogue box will pop up, from the
drop down select the size 4 inch and click 2Apply®.

Select component dialogue box will pop up to
select the reducer size, rating and end condition
and click @Create®.

Line will be changed to 4 inch and reducer will be
added at both ends.
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Chapter 10-3 Jog Route.

A complete plant consists of many processes, di"erent types of piping components, materials, schedules and
rating are required. Some of the processes may require loop in route line like High Saturated Steam or High Pressure Stea
may expand due to the high temperature, so in order to avoid accidents we will place a loop in between the route line.

SolidPlant3D provides you with an advanced feature known as 2Jog Route® with this you can create a loop with
just a single sketch and the route line will update or rebuild automatically.

Let's learn how to create a jog route, for example
we want to create a loop for this line.

Double-click the line to activate edit mode or edit
sketch mode, go to 2Routing® tab, click on
aJog Route° feature.

After you activated the jog route feature click
on the sketch line to add the loop or jog to that
segment.

Draw the sketch as shown, right-click the mouse
to accept the route line, whole route line will be
rebuild with the components.

Exit the sketch and exit assembly after you #nish. This feature will also come in handy when you're designing
control stations.
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Chapter 10-4 Split Pipe.

Generally Pipe lines may be many kilometers long but according to the standards of the pipes, each pipe will be
of speci#c length, if we want to show the stock length of the pipe in a route line it requires too many man hours, to reduce
this e"ort Solidplant3D has a phenomenal feature known as 2Split Pipe® With this feature you can split the whole pipe with
exact dimension and also you can place $anges at this split point.

Double-click the line to activate edit mode,
select the line that you want to split, go to 2Routing®
tab, select2Split Pipe® feature.

After you have activated Split Pipe feature, Split pipe
dialogue box will pop-up input the dimension you
want to split the pipe into and select from which
point you want to start as reference.

You can observe the whole line will split into equal
parts according to the given dimension.

Exit the sketch or select all the points, go to
aComponent® and select 2Flange® feature.
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Select component dialogue box, (it) will pop up to select the type, rating and end condition for $ange and bolts,
select the required $ange and bolts. Then $ange pairs will be created at the points.

Chapter 11 Generate Piping Isometric Drawing

Chapter 11-1 Isometric Drawing.
Isometric drawing is way of presenting designs/drawings in three dimensions. In order for a design to appear
three dimensional, a 30 degree angle is applied to its all axis.
t" QJQJOH JTPNFUSJD ESBXJOH JT B % ESBXJOH JO XIJDI QJQJOH ¢
only x and y co-ordinates are used to draw entire drawing.
t *TPNFUSJD -BZPVU *TPNFUSJD MJOFT DBO CF JO WFSUJDBM EJSFL
directions of the pipe may match the three isometric axis lines.
t *U JT QPQVMBS XJUIJO UIF QSPDFTT QJQJOH JOEVTUSZ CFDBVTF J
piping in a realistic view.
t *U JT VTFE BMPOH XJUI QMBOT BOE TFDUJPOBM FMFWBUJPOT CVU
t *TPNFUSJDT BSF VTFE BT GBCSJDBUJPO TIPQ ESBXJOHT GPS GBC
t *TPNFUSJDT BMTP QSPWJEF B ESBGUFS XJUI UIF BCJMJUZ UP DBMI

Why Isometric Drawings are required?

Generally in the development of a project, a conceptual 2D drawing is #rst created. In this all pipelines are drawn
at zero z co-ordinate. This is then converted into a 3D scale model, to check interference of pipe lines. 2D Geaagd-A
ment (GA) drawings are used for fabrication on site. A GA drawing is generally on A0 or Al size paper and contains a lot
lines, and may not be easy to understand pipe routine. A0 or Al size drawing is too big to handle. A pipe fabricator car
understand a GA drawing better only with the help of a 3D scale model. But a 3D scale model cannot be put on a paper
and a 3D scale model does not indicate dimensions. To aid the pipe fabricator on site, isometric drawings are prepared. Al
isometric drawing is generally on a A3 size paper. A pipe fabricator can read it and understands the pipe routine easily. Als
the pipe fabricator can pick up the materials required for fabrication of pipe lines from stores, with the help of the Bill of
Material given in isometric drawing.

SolidPlant3D has an integrated engine called 2lsoGen°to generate Isometrics within the SolidPlant environment.
Now you can generate Isometric drawings anytime. Engineers, pipe designers and contractors worldwide recognize this
format and this allows you to share your pipe design with con#dence knowing they will be understood.

Chapter 11-2 Generate Piping Isometric Drawing.

In SolidPlant you can generate two types of Isometric drawings.
(i) Isometric drawing for whole line.
(i) Isometric drawing for selected components.

Isometric Drawing for Whole Line: Generate Isometric for entire line just by selecting the line number in the Isogen
dialogue box, this will be very handy for the piping designers to generate isometrics for entire project.

Isometric Drawing for selected Components: In some cases you may require isometric for few components to verify the
correctness and completeness of the route line, this type may come in handy.
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Chapter 11-3 Generate Isometric by selecting Tag number.
To generate Isometric go to 2Drawing® tab, select2Gen PCF° feature.

After you select the 2Gen PCF° feature Isogen
Dialogue box will appear with all the line numbers.

You need to select the line number which you want to generate the Isometric drawing. Isometric may be generat-
ed in dilerent styles i.e check, "nal-basic, "nal-cutlist, "nal-erection and many more.

You can also generate only PCF "le that you can import into any stress analysis application. You can also generat
only isometric drawing without generating PCF "le.

OK, now select a line to generate Isometric.

Let's select2LO100° Drawing style: Final-Cutlist
and click on PCF & Drawing button.

You can notice the processing bar while it creates the Isometric drawing for us.
Isometric will be created and opened in a separate window and informs you with an alert message.
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Please look at the Isometric drawing with all the detailed information generated within a short matter of time. All
the Material List for Fabrication, Material list for Erection and Cutting list will be generated.

Chapter 11-4 Generate Isometric by selecting Tag number.
To generate Isometric go to 2Drawing® tab, select2Gen PCF° feature.

After you select the 2Gen PCF° feature the Isogen Dialogue box will appear with all the line numbers.
click on Selected items check box.

Now, you need to select the components from the
3dmodel which you want to generate the Isometric
drawing.

You can observe the selected components or items will be visible in the IsoGen dialogue box.
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Change drawing style to check and click on PCF & Drawing button.

Isometric will be generated.

Chapter 12 Create General Arrangement Drawing

Chapter 12-1 General Arrangement Drawing.

General Arrangement drawings for piping systems and equipment are developed by piping designers. These
drawings indicate the locations of main equipment in the plant. The main piping items, valves, and "ttings are also indicat-
ed in the General Arrangement or GA drawings. Most often the piping is indicated using a top-view. Sometimes a side view
of the pipe rack is also presented on the GA drawing.

General arrangement drawings are also developed for individual equipment. These drawings present the main
dimensions of that equipment using 2D views, top-view, side-view and sometimes front-view. All the nozzles for concerned
equipment are indicated on the equipment General Arrangement or GA drawing.

Chapter 12-2 Insert View on drawing.
This chapter will teach you how to insert the view on drawing. Go to2DrawingPtab, select2New Drawing® feature.
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Then SolidPlant drawing template will open in a separate window. Select the top view as we are preparing the GA
drawing. Change the scale to 1:100.

Now go to options of SolidWorks, click on the Document properties -> Detailing -> check 2use model color for
HLR/HLV in drawings and click 20K®

Layout will regenerate and appear same as model color.

We can show the dimensions, Line numbers and COP of the pipe using tools on the drawing tab.

Click on Smart Dimension, select the line.
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Now go to @Drawing® tab, select the line and click on line number feature, select elbow and click on COP feature,
select Tank and click on TAG feature and arrange as you needed.

In the same manner you can annotate all the layout according to your needs.

Chapter 13 Create Bill of Material

Chapter 13-1 Bill of Material.
This chapter will explain you how to create Bill of material. A Bill of Materials (BOM) de"nes the material require-
ment for a project, speci“ed in terms of drawings, stock or component codes, and the quantities of each item required.

A Bill of Materials may be generated in total as a single BOM for the complete project, or as a number of smalle
BOMs, perhaps on a discipline by discipline basis or, on a per area basis.

In SolidPlant we can generate bill of material in two ways
(i) Generate BOM in GA Drawing
(ii) Export the BOM into Excel format

Chapter 13-2 Generate Bill of Material.
To Generate Bill of Material, select in view in the drawing sheet, go to 2Drawing® tab, select 2 BOM® feature.

When you click on the BOM feature bill of material
dialogue box will appear with all the details same
as beside.

You can see the detailed information regarding all
the equipment and Piping system in the entire project.
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Click 2Close® and the table format will appear
on the drawing.

Chapter 13-3 Export Bill of Material to excel.

To Generate Bill of Material, select in view in the
drawing sheet, go to @DrawingP tab, select2BOMP°
feature.

When you click on the BOM feature bill of material
dialogue box will appear with all the details same
as beside.

You can see the detailed information regarding all
the equipment and Piping system in the entire
project.

Click on2To Excel® Button. Save as dialogue box will
pop up, give name and save at your desired location.

An excel !le will be created and opened automatically.
Review the data.




